
 

TKS-932/935/936 仿真器快速入门 
（2005/03/16  V2.2） 

 

注：本用户使用手册适用于 TKS-932、TKS-935 和 TKS-936，以下统称为 TKS-900。 
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一、TKS-900 技术特点和背景资料 
 

TKS-900 仿真器是广州致远电子有限公司推出的系列实时在线仿真器，TKS-900 完全支持 PHILIPS 公

司 P89LPC900 系列芯片的仿真（TKS-932、TKS-935 分别支持 P89LPC932、P89LPC935 以下芯片的仿真，

均可有偿升级到 TKS-936，支持 P89LPC938 以下芯片的仿真）。在仿真性能上进行了全面的优化设计，能保

证用户更加方便的操作和真实的仿真效果。 

 

z 兼容 Keil 公司的硬件仿真环境，使用户能够在先进的编译环境下编译，同时也能在先进的仿真

环境下进行硬件仿真； 

z 使用 PHILIPS 公司授权的专用 BondOut 芯片，仿真更加真实； 

z 采用更加合理的 BondOut 通讯方式，BondOut 工作更加稳定； 

z 真实仿真 LPC900 的掉电模式和空闲模式； 

z 真实仿真 LPC900 的各种方式的复位（软件复位、看门狗复位、外部复位）； 

z 支持用户程序嵌入配置字节，使用户仿真/烧写更加方便可靠，同时在仿真中可随意观察和修改

用户配置字节（等待标准制定）； 

z 内部更加可靠的保护，避免使用中误操作引起仿真器的损坏； 

z 连续单步运行速度更快； 

z 支持使用外部用户电源电压，用户提供的电源电压最低可达 3.3 伏； 

z 支持使用外部复位信号； 

z 仿真时多而详细的状态信息提示，帮助用户迅速查找目标系统的故障； 

z 系统内部多种检查，当系统配置错误时避免进入错误的运行状态。 
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二、 TKS-900 仿真器型号的分类 

 

在 TKS-900 发货时，根据内部的仿真芯片 BondOut 的不同可能会有几种型号： 

 

z TKS-932（内置仿真芯片 P89LPC932）。可以仿真 P89LPC932 以下的 LPC 型号。该型号可以直接

升级到 TKS-935/936，以支持 P89LPC935/938 功能以内芯片的仿真。 

z TKS-935（内置仿真芯片 P89LPC935）。可以仿真 P89LPC935 以下的 LPC 型号。该型号可以直接

升级到 TKS-936，以支持 P89LPC938 功能以内芯片的仿真。 

z TKS-936（内置仿真芯片 P89LPC936）。可选 P89LPC938 仿真芯片，以仿真 P89LPC938 以下的 LPC

型号。 

 

用户在选购 TKS-900 时，可以购买指定的型号，同时也可以另外购买另外一种型号仿真芯片，以备将

来更换使用。 
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三、TKS-900 仿真器使用前应该了解的知识 
 

TKS-900 仿真器是 TKS 系列仿真器的一个品种，用户在使用前须仔细阅读《TKS 系列仿真器用户使用

手册》的有关事项，在具备以下条件后可以开始熟悉使用 TKS-900 仿真器。 
1. 熟悉 Windows 的系统操作以及一般应用软件的操作技能。 

2. 了解 PHILIPS 公司的 P89LPC900 系列单片机的原理。 

z 了解一般的电子电路知识。 

z 准备一台符合要求的计算机和操作系统。 

z 安装并熟悉 Keil 的µVision2 集成开发环境。 

  

另外，在开始使用 TKS-900 仿真器前，您首先应该熟悉一下 TKS-900 仿真器的硬件。在您购买回来的

仿真器套件中，有几样东西是必须使用的： 

z 仿真器主机：完成仿真功能的最主要部分。 

z 仿真器电源：为仿真器主机提供工作电源。它的输入电源为交流 220V。 

z 仿真头：带有 28 脚 LPCC 插座，可以插入用户目标板的插座中。它的另外一端通过仿真电缆连

接到仿真主机，这样把仿真主机和用户目标板连接起来。 

z 仿真电缆：40 芯的扁平电缆，用于连接仿真器主机和仿真头。随机提供的仿真电缆有两种长度规

格。较长的一种便于用户连接用户目标板；当用于较高频率或工作于干扰较大的环境时可使用较

短的仿真电缆。 

z RS-232 串口通讯电缆：用于连接仿真器主机和您的计算机，长度为 1.5m 。 

 

与 TKS-900 配合使用的可选附件有： 

z TB932-PLCC28： 28 脚 PLCC 插座仿真头，用于仿真 P89LPC900 中的 28 脚 PLCC 封装； 

z TB900-DIP28：  28 脚 DIP 针状插座仿真头，用于仿真 P89LPC900 中的 28/20 脚 DIP 封装； 

z TB900-DIP14：  14 脚 DIP 针状插座仿真头，用于仿真 89LPC912/913/914 的 14 脚 DIP 封装； 

z TB901-DIP8：  8 脚 DIP 针状插座仿真头，用于仿真 P89LPC901/902/903/904 的 8 脚 DIP 封         

装； 

z TB906-DIP8：  8 脚 DIP 针状插座仿真头，用于仿真 P89LPC906/907/908 的 8 脚 DIP 封装； 

z TB9401-D64：  64 脚插座仿真头，用于仿真 P89LPC9401 的 64 脚 LQFP 封装； 

z TB915-DIP14+2： 14/16 脚 DIP 针状插座仿真头，用于仿真 P89LPC915 的 DIP14 封装、916/917       

的 DIP16 封装； 

z P89LPC932 仿真芯片：在 TKS-932 中使用； 

z P89LPC935 仿真芯片：在 TKS-935 中使用；TKS-932 升级到 TKS-935 后也可以使用； 

z P89LPC936 仿真芯片：在 TKS-936 中使用；TKS-932、TKS-935 升级到 TKS-936 后也可以使用； 

z P89LPC938 仿真芯片：在 TKS-936 中使用；TKS-932、TKS-935 升级到 TKS-936 后也可以使用； 

z 其它陆续推出的 LPC 仿真芯片 BondOut。 
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四、 TKS-900 在 Keil 中的快速操作 
 

Keil 软件是德国 Keil Software/Keil Elektronik 开发，近几年在国内得到迅速普及，最新的 7.01 版本已经

支持 LPC900 的软件/硬件仿真，用户可以向 Keil 公司的国内代理商广州周立功单片机发展有限公司购买正

式软件或索取 Demo 版本，也可以直接到 Keil 公司的网站下载该 Demo 软件。Keil 公司的网址是：

http://www.keil.com。 

当您得到该软件的安装软件后，您可以按照提示进行安装。安装完毕后，您就可以在这套功能强大的开

发平台上完成您所有的设计工作，包括源程序的编写，程序的编译和连接，软件模拟仿真的验证和排错，最

后您可以使用 TKS-900 在 Keil 中进行硬件的仿真和调试，直到最终完成您的设计。 

在安装完毕后，您就可以编写一个简单的程序来熟悉 Keil 的 IDE 环境，也可以使用 Keil 软件本身提供

的范例程序，下面我们主要结合 Keil 的范例程序 Hello 来讲解 Keil 的具体使用。 

当您安装完毕后，Hello 程序位于\Keil\C51\EXAMPLES，具体驱动器的位置取决与您的安装选择，如果

您选择的是缺省安装，Keil 将会安装在 C 盘。 

 

4.1  打开 Hello 工程 

在 Keil 中文件的管理使用的工程的方法，而不是以前的单一文件的模式。您的所有的文件包括源程序

（包括 C 程序，汇编程序），头文件，一般的文本文件都将放在工程里统一管理。在使用 Keil 前，您应该习

惯这种工程的管理方式。 

点击 Keil 的图标启动 Keil 程序，然后您就可以看到 Keil 的主界面。在有的版本中 Hello 工程会自动打

开。如果您没有看到 Hello 工程或看到的不是 Hello 工程，您可以点击 Project->Open Project 按照前面提示的

路径找到该工程文件。 

Hello 工程是一个简单的 C 语言单模块程序，完成的主要就是通过串口发送“Hello World“字符串。 

工程管理窗口             文件编辑窗口             信息输出窗口 

 

 

 

 

 

 

 

 

                                

          

       

 

 

 

 

 

 

 

 

 

图 4.1  标准编译界面 
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4.2  为工程选择目标器件 

 

在打开工程以后，还应该为您的工程选择合适的目标器件。使用 TKS-900 您必须选择 51LPC 系列为目

标器件。选择方法为：点击菜单 Project->Select Device for Target…后出现图 4.2 的对话框。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

图 4.2  目标器件选择界面 

 

  在此对话窗中，左边的 Data base 窗口中把 Keil 所支持的器件按照生产厂商进行分组列表。您可以点开

PHILIPS 组，找到并选择 P89LPC932，按动对话框上的确定按钮。在您选择了 P89LPC932 后，仿真时系统

将根据所选定的器件为您提供一些特定的功能选择。例如，如果您选择了 P89LPC932，进入仿真在 Peripherals

菜单中将会增加很多外设观察选择，例如外设菜单中的 System Configuration 项目就为您提供了观察和修改

P89LPC932 内部 UCFG1 单元的浮动窗口。 

 

4.3  编译和连接 Hello 工程 

 

对于已经打开的 Hello 工程，里面已经为您设置好了所有的系统配置，因此您可以直接进行编译和连接。

对于您自己新建立的工程文件，需要您自己加入文件和进行编译环境等设置，有关 Keil 的设置在下面叙述。 

选择菜单 Project->Rebuilt All Target Files，Keil 将对 Hello 工程进行连接和编译，操作结果的信息显示

在输出窗口。如果用户没有对 Hello 工程做任何的改动，编译和连接将会正确完成。编译和连接的结果在信

息输出窗口输出，如图 4.3 所示。 

 

 

 

 

 

 

图 4.3  编译结果在信息输出窗口的输出 
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经过编译和连接后，Hello 工程已经可以进行模拟仿真或硬件仿真。模拟仿真是利用 PC 的资源模仿单

片机的运行，优点是简单，不需要动用硬件，缺点是对于外部信号无法进行正确的仿真；硬件仿真正好相反，

但硬件仿真是调试的必须步骤，下面我们主要讲述硬件仿真。 

 

4.4  仿真 Hello 工程 

 

① 仿真器驱动程序声明（以 TKS-935 为例）： 

在配置仿真器前，请将随机提供的 TKS-935 仿真器驱动文件 TKS_935.DLL（TKS-932、TKS-936 的驱

动文件分别为 TKS_932.DLL、TKS_936.DLL）拷贝到 Keil 的安装目录中。例如，如果您的 Keil 的安装目录

为 C:\Keil，则将 TKS_935.DLL 拷贝到 C:\Keil\C51\bin 目录下。然后打开 C:\Keil 目录下的 Tools.ini 文件，

在几个分类中找到[C51]类别，加入下列描述： 

TDRV3=bin\TKS_935.DLL  ("TKS-935 Emulator")   其中： 

z TDRV3 是驱动 DLL 的序号，如果您前面已经安装了多个驱动 DLL 以致占用了 TDRV3，则将 TKS

的驱动程序序号向后顺延，例如 TDRV5。随机软件的 Tools.ini 文件可用来参考如何加入驱动程序。需注意

的是该文件中驱动程序说明行所指出的路径可能和您的不同，这要根据您的 Keil 软件在硬盘中的安装位置。 

z bin\TKS_935.DLL 是驱动程序放置的路径，该路径下必须有 TKS_935.DLL 文件。 

 

② 仿真环境的设置： 

击菜单 Project->Option for Target..进入工程配置对话框，选择 Debug，出现图 4.4 的对话框。在这个对

话框中，主要供用户选择仿真时需要的一些设置。在这些设置中，请用户仔细按照下面的要求选择，不正确

的选择将会造成仿真的困难和不准确，甚至是难以理解的现象！ 

软件仿真选择                                硬件仿真选择     启动运行选择    仿真器参数设置 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                             仿真目标器件驱动选择   仿真配置记忆选择   仿真器类型选择 

图 4.4  仿真配置界面 
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z 软件仿真选择：使用软件仿真当前的设计。 

z 硬件仿真选择：使用硬件仿真当前的设计。使用 TKS-900 必须选择硬件仿真。 

z 仿真器类型选择：用于选择当前的硬件仿真驱动。如果用户在 C:\KeilTools.ini 文件中正确填写了

TKS 的驱动说明，而且该说明行所指向的路径也有对应的 DLL 文件，则用户可以选中 TKS 驱动

项目。 

z 启动运行选择 

Load Application at Start：进入仿真后调入程序代码进入仿真器。 

Go till main：在使用 C 语言设计后直接运行到 main（）函数。 

z 仿真配置记忆选择 

Breakpoints：记忆当前设置的断点，下次进入仿真后该断点设置存在并有效。 

Watchpoints：记忆当前设置的观察项目，下次进入仿真仍有效。 

Memory Display：记忆当前存储器区域的显示，下次进入仿真仍有效。 

Toolbar：记忆当前的工具条设置，下次进入后仍有效， 

z 仿真目标器件驱动程序选择 

如果用户在目标器件选择中选择了相应的器件，Keil 将自动选择相应的仿真目标器件驱动程

序。在图 4.4 中，Keil 选择了标准 S80C51.DLL 驱动文件，Dialog .DLL 选择了 TLPC-pLPC932。

Keil 根据不同的器件选择不同的仿真驱动 DLL，这样在仿真时就会有该器件相应的外设菜单。用

户进入仿真（硬件仿真和软件仿真）后，在 Peripherals 菜单中会添加该器件的外设观察菜单，用

户点击后会出现浮动的观察窗口，方便用户观察和修改。  

z 硬件仿真参数设置：该配置项主要设置硬件仿真的重要选项，用户要仔细选择。点击 Settings 进

入图 4.5 的对话窗。 

 

通讯选择区域                缓冲选择区域 

 

  

 

串口选择                                                        使用可直接寻址数据缓冲 

                                                                使用可间接寻址数据缓冲 

                                                                使用外部数据 xdata 缓冲 

波特率选择                                                       使用代码数据 code 缓冲 

时钟选择区域                                                                   

内部 24M 时钟                                                     时钟工作模式选择 

内部 12M 时钟                                                     

内部 6M 时钟                                                          UCFG1 数据 

仿真头上时钟                                                     启用看门狗安全位 

附加选择区域                                                      启用掉电检测 

使用外部复位                                                          启用复位引脚 

使用外部电源                                                          启用看门狗         

      

           搜索通讯端口 

 

图 4.5  仿真硬件配置界面 
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Com Port Settings 串口设置区域 

z Port：选择硬件仿真器使用的串口。TKS 使用串口同 Keil 进行通讯。 

z Baudrate：串口使用的波特率。TKS 使用的是自动适应波特率，也就是该选项在一定选择范围 

内 TKS 都能正常工作。选择快的波特率能加快运行速度，但是低的波特率在环境恶劣的条件下更可靠。TKS

适应的波特率范围在 1200-57600 之间，但根据用户的实际情况略有差异。 

注意：选定波特率后，必须先接通 TKS-900 仿真器电源，仿真器主机面板上的指示灯闪烁结束后，才

可以运行 Keil 的硬件仿真程序。在硬件仿真环境中用户可以在 Peripherals 菜单中打开 Target Settings 窗口（图

3.5）来更改波特率，更改后整个系统重新建立连接；也可以更改串口，但是用户必须在更改后的串口上连

接仿真器。 

 

Catch Option 选择区域：使用存储器缓冲区域，这样在一般的操作中仿真软件不用频繁的读取仿真器

中的内容，而使用缓冲区域。使用缓冲可以大大加快仿真速度，建议用户将该区域选项全部选中！使用缓冲

的缺点是屏幕的数据刷新慢，但是在单步或运行后所有在屏幕上显示的信息将全部刷新一次。 

 

Select Oscillator 选择区域：选择仿真时使用的时钟。用户可以选择仿真器内部提供的 3 个时钟频率选

择，也可以选择外部时钟（仿真头振荡器产生的时钟或用户目标板上的时钟，但是不支持用户目标板上的晶

体）。选择仿真内部时钟系统的性能最稳定，但是只提供 12M/6M/3M 3 个频点给用户使用；选择外部时钟用

户可以根据自己的要求来选择频率，只需要在仿真头上插入希望的晶振或使用目标系统板上的时钟（不是晶

体）。由于外部时钟信号从外部引入到仿真器内部，中间要经过仿真电缆和接插件，因此稳定性和抗干扰性

能不如使用内部时钟，如果用户需要特殊频率的时钟可以采用这种选择。 

由于 P89LPC900 系列单片机时钟配置的灵活性，TKS-900 的时钟源选择也有更加多的功能，功能的变

化主要依赖与 UCFG1 的配置数据。 

z UCFG1 配置为高/中/低频/外部时钟。在这种选择下，用户可以使用以下 5 种时钟选择。点击任何

12M/6M/3M/TestBoard 选项将施加相应的时钟，点击当前的时钟选项将关闭全部的

12M/6M/3M/TestBoard 的时钟，用户必须在目标板上从 X1 脚输入脉冲信号作为单片机的时钟。 

� 12M 仿真器内部提供的时钟。在这种选择下，用户对 X1 脚不允许连接任何驱动电平，也不

允许连接大的负载，包括晶振和负载电容。 

� 6M 仿真器内部提供的时钟。其余同上。 

� 3M 仿真器内部提供的时钟。其余同上。 

� 仿真头（TestBoard）上振荡电路提供的时钟。用户必须使用仿真电缆连接仿真头，并将振荡

板插入到仿真头上，并将合适的晶振插入到振荡板的晶振插座中，晶振的频率范围大约为

1M-12MHz。用户在使用特殊的时钟时，也可以使用 4 脚有源晶体替代振荡板插入到仿真头

的插座中，但是注意不要插反，有源晶体的 1 脚对应振荡板 4 脚插座的 1 脚。 

� 用户目标板提供的时钟。用户可以在自己的目标板上提供时钟，直接驱动 X1 脚，但是要取

消所有的时钟选择。方法是用鼠标单击当前的时钟选择，可以看到 12M/6M/3M/TestBoard

的 4 种时钟选择全部不选中。 

z UCFG1 配置内部 RC/WatchDog 时钟。在这种选择下，LPC932 的运行时钟用户不能选择，用户一

般可以看到 12M/6M/3M/TestBoard 全部不选中。根据 LPC932 的时钟特性，X1/X2 脚仍可以产生

时钟为内部的实时时钟电路提供工作，但要对 RTCCON 进行配置。用户仍可以使用以下 5 种时

钟选择作为 RTC 的时钟源。点击任何 12M/6M/3M/TestBoard 选项将施加相应的时钟，点击当前的

时钟选项将关闭全部的 12M/6M/3M/TestBoard 的时钟，用户必须在目标板上从 X1 脚输入脉冲信

号作为 RTC 的时钟。 

� 12M 仿真器内部提供的时钟。在这种选择下，用户对 X1 脚不允许连接任何驱动电平，也不

允许连接大的负载，包括晶振和负载电容。 



TKS-932/935/936 仿真器快速入门手册……….全面支持 Keil  C51 调试环境的高性能实时在线仿真器 

 10

� 6M 仿真器内部提供的时钟。其余同上。 

� 3M 仿真器内部提供的时钟。其余同上。 

� 仿真头（TestBoard）上振荡电路提供的时钟。用户必须使用仿真电缆连接仿真头，并将振荡

板插入到仿真头上，将合适的晶振插入到振荡板的晶振插座中，晶振的频率范围大约为

1M-12MHz。用户在使用特殊的时钟时，也可以使用 4 脚有源晶体替代振荡板插入到仿真头

的插座中，但是注意不要插反，有源晶体的 1 脚对应振荡板 4 脚插座的 1 脚。 

� 用户目标板提供的时钟。用户可以在自己的目标板上提供时钟，直接驱动 X1 脚，但是要取

消所有的时钟选择。方法是用鼠标单击当前的时钟选择，可以看到 12M/6M/3M/TestBoard

的 4 种时钟选择全部不选中。 

如果用户在程序中并没有使用 X1/X2 上的时钟作为实时时钟（RTC）的时钟源，则上述施加的时

钟没有意义。注意在这时不要把 X1/X2 配置成强输出模式，以免和施加的时钟信号产生一定程度

的短路！ 

 

Aux. 选择区域 

z Use Ext. RST 使用外部复位输入选择 

如果用户选择该项，则仿真运行动作（单步，全速，全速断点）会根据外部复位信号的电平来动作。

如果在开始运行前发现有效的外部复位电平，仿真器将提示用户，并停止运行，等待用户解除外部复位；如

果在运行当中发现有外部复位信号，系统也将提示用户，并复位系统，复位信号解除后重新运行。注意该选

择项只在 UCFG1 的 RPE 开启后才有意义，RPE 关闭用户将无法启动该选项。 

z Use Ext. Power 使用外部电源选择 

使用外部电源作为仿真电源。在不使用外部电源时，使用的是内部的+3.3V 电源，要求用户板上的电源

也必须是+3.3V，但是允许有 0.7V 的上下偏差。如果用户需要仿真的电压跟+3.3V 差距过大，则可以选择该

项。使用的外部电源电压必须在 2.5V-3.6V 之间。外部输入电源从用户板得到，经过仿真头电源脚进入仿真

器内部。外部输入电源最低电压为 2.5V，小于 2.5 伏内部电压将维持在 2.5 伏不变；外部输入电压最大为 3.9V，

超过 3.9V 将引起内部保护装置的启动。 

如果您正确完成上述操作，您就可以进入下面的操作。 

 

System Configation 区域 

z 时钟工作模式选择 

用户可以选择仿真芯片的时钟工作模式，对应与 UCFG1.2-0，用户共有高/中/低频晶振，内部 RC，看

门狗时钟和外部时钟 6 种选择。用户选择不同的时钟模式也就改变了 UCFG1.2-0。 

z UCFG1 数据 

系统当前 UCFG1 的数据显示。 

z 启用看门狗安全位  对应 UCFG1.4 

启用掉电检测   对应 UCFG1.5 

启用复位引脚   对应 UCFG1.6 

启用看门狗   对应 UCFG1.7 
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五、 使用 TKS-900 进行仿真 
 

(1) 用随机提供的串口电缆连接 TKS-900 和 PC 机。注意选择的串口号必须同 Keil 硬件仿真设置中的选

择一致。 

(2) 将随机提供的电源适配器的交流端子插入 220V 交流电源，另一端接入 TKS-900 的电源插座。这时，

TKS-900 的指示灯将闪烁，闪烁停止后仿真器进入命令等待。 

(3) 点击菜单 Debug->Start/Stop Debug Session，Keil 将进入硬件仿真状态。 

主寄存器窗口             反汇编窗口    源程序窗口    外设窗口 

 
 

命令行输入  帮助文件启动   命令执行结果显示窗口  变量显示窗口  存储器空间显示 

 

图 4.1 标准硬件仿真界面 

关于更为详细的资料，点击上图中的帮助文件启动，参考 Keil 的随机文档。根据经验，用户在使用 Keil

的仿真环境时，最为困难的是具体的操作问题，下面是一些最为常用的操作。 

 

查看和修改主寄存器的内容 

 

仿真时主寄存器的内容在主寄存器窗口显示，用户除了可以观察以外，还可以修改。用鼠标点击选中一

个单元，例如 SP，然后再单击 SP 的数值位置，出现文字框后输入希望数值按回车即可。 

另外的输入方法是使用命令行窗口。例如，输入“A=0x34”将把 A 的数值设置为 0x34。 



TKS-932/935/936 仿真器快速入门手册……….全面支持 Keil  C51 调试环境的高性能实时在线仿真器 

 12

观察和修改变量 

 

点击 View->Watch & Call stack Window，该窗口出现后，选择 Watch1-3 中的任一个窗口，按动 F2 后在

Name 栏填入变量的名称，如 DPTR，TL0 等；也可以输入用户自己定义的变量名称，如 Temp1，Counter 等，

但必须是存在的变量。如果想修改数值，可单击 Value 栏，出现文本框后输入希望的数值。 

 

观察反汇编程序 

 

如果用户的源程序是用 C 语言写成的，进入调试环境中可能会不出现反汇编窗口。用户可以从

View->Disassembly Window 打开反汇编窗口。在反汇编窗口中点击鼠标右键，可以看到多种针对反汇编的操

作，包括反汇编显示模式，在线汇编，和程序代码的调入。 

 
 

 

step over 

step info 

停止运行按钮 

全速运行按钮 

复位按钮 

运行程序 

 

在 Keil 的仿真环境中，有几种运行方式： 

z Run 全速运行，遇到断点停下或用户按动 Stop 按钮停止。 

z Step info 单步跟踪运行一条指令。如果该语句为 C 中的调用子程序语句或汇编中的 CALL 指令，

Step info 指令将跟踪进入子程序内部。 

z Step over 单步运行完一条指令。如果该语句为 C 中的调用子程序语句或汇编中的 CALL 指令，

Step over 指令将全速完成该子程序的运行，停在下一指令处。 

z Run till Cursor Line 从当前位置运行到光标处。 

另外，用户还必须注意当前的运行背景，即是在源程序背景下还是在反汇编背景下，源程序分汇编程序

和 C 语言程序。在不同的背景下，使用上述运行方式会有所不同。在汇编源程序和反汇编背景下，Step Info

每次只执行一条汇编指令，遇到 CALL 指令会跟踪到调用程序内部；而 Step over 是在执行 CALL 指令后完

成执行被调用的指令，停在 CALL 的下一条指令上。在 C 语言源程序背景下，Step Info 是执行一条 C 语言

程序，这条 C 语言程序可能包含多条汇编程序，但是不包含调用函数。如果该语句中包含调用函数，经过

Step Info 运行后将跟踪到调用函数内部。Step over 则是执行完被调用的函数，其简单语句的作用同 Step Info。 

 

复位按钮的作用 

 

在 Keil 的仿真环境中，工具条中有 Reset 按钮，表示系统的复位。在 TKS-900 中，复位按钮的作用相当

于外部信号复位，这种复位同上电复位不同，它不影响上电标志位。 

 

退出仿真状态 

 

在仿真状态中，用户不可以再对工程进行编译和连接。退出仿真的方法同进入一样，点击菜单

Debug->Start/Stop Debug Session，Keil 将退出硬件仿真状态。 
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六、TKS-900 的物理结构 
 
 

 

 

                                            监控指示 LED 灯  

                                            运行指示 LED 灯 

                                            电源指示 LED 灯 

 

         仿真电缆插头                                       串口插座 

 

                                                          电源插座 

                              

 

图 5.1  TKS-900 平面图（顶部俯视） 

 

z 监控指示 LED 灯： 点亮表示处于监控状态。 

z 运行指示 LED 灯： 点亮表示进入运行状态。 

z 电源指示 LED 灯： 点亮表示系统电源正常。 

z 仿真电缆插头： 插入仿真电缆连接到仿真头。 

z 串口插座：  插入串口通讯电缆连接到计算机。 

z 电源插座：  输入仿真器主机工作需要的电源。 
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七、仿真头组件的使用 
 

表 7.1 列出了仿真头型号与适用芯片的对应关系，其详细的使用说明请参见下面各节所述。 

表 7.1 仿真头组件一览表 

仿真头型号 适用芯片 管脚封装 

TB932-PLCC28 P89LPC935/932/931/930 PLCC28 

TB900-DIP28 P89LPC935/932/931/930/922/921/920 DIP28、DIP20 

TB900-DIP14 P89LPC914/913/912 DIP14 

TB901-DIP8 P89LPC904/903/902/901 DIP8 

TB906-DIP8 P89LPC908/907/906 DIP8 

TB9401-D64 P89LPC9401 64 脚插座 

TB915-DIP14+2 P89LPC917/916/915 DIP16、DIP14 

TB9102-DIP10+4 P89LPC9102/9103/9107 DIP14、DIP10 

 
7.1 TB932-PLCC28 

 

28 脚 PLCC 插座仿真头，用于仿真 P89LPC900 中的 28 脚 PLCC 封装； 

该仿真头组件适用的器件型号为：P89LPC935/932/931/930 的 PLCC28 封装。 

 

仿真头电缆插座 

用户测试接地端                                                        电源指示 

                                           

                                              仿真     PLCC28 仿真插座 

振荡板                        晶振插座  

左             晶振插座 

 

图 7.1  仿真头结构示意图（正面俯视） 

z 仿真头主板 

 

仿真头电缆插座： 使用时用仿真电缆连接仿真器和仿真头。 

用户测试接地端： 用户在进行测试时，可以使用该端作为地参考点。 

振荡板：  如果您选择使用了仿真头时钟，您必须将振荡板插入仿真头主板，并在晶振插座

位置插入合适频率的晶振。 

PLCC28 仿真插座： 用于连接仿真器和用户目标板。 

电源指示：  仿真头插入仿真器主机或仿真头电源脚有电压输入则该 LED 点亮。 

 

z 仿真电缆 

 

仿真电缆为 40 芯扁平电缆。     

 

z 振荡板 

 

振荡板是一块单独的 PCB 板，用于产生外部时钟，需要时可以插入仿真头主板（注意插入方向）。 

  振荡板在使用时必须在上面的晶振插座上插入正确频率的晶体。注意 TKS-900 的最高频率为 12MHz. 
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7.2 TB900-DIP28 

 

28 脚 DIP 插座仿真头，用于仿真 P89LPC900 中的 28/20 脚 DIP 封装； 

该仿真头组件适用的器件型号为：P89LPC922/921/920的DIP20封装。 

 

仿真头电缆插座 

用户测试接地端                                                        电源指示 

                                           

                                              仿真     DIP28/20 仿真插座 

振荡板                        晶振插座  

左           晶振插座 

 

图 7.2  仿真头结构示意图（正面俯视） 

 

z 仿真头主板 

 

仿真头电缆插座： 使用时用仿真电缆连接仿真器和仿真头。 

用户测试接地端： 用户在进行测试时，可以使用该端作为地参考点。 

振荡板：  如果您选择使用了仿真头时钟，您必须将振荡板插入仿真头主板，并在晶振插座

位置插入合适频率的晶振。 

DIP28/20 仿真插座： 用于连接仿真器和用户目标板。 

电源指示：  仿真头插入仿真器主机或仿真头电源脚有电压输入则该 LED 点亮。 

 

z 仿真电缆 

 

仿真电缆为 40 芯扁平电缆。     

 

z 振荡板 

 

振荡板是一块单独的 PCB 板，用于产生外部时钟，需要时可以插入仿真头主板（注意插入方向）。振

荡板在使用时必须在上面的晶振插座上插入正确频率的晶体。注意 TKS-900 的最高频率为 12MHz。 
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7.3 TB900-DIP14 

 

14 脚 DIP 插座仿真头，用于仿真 P89LPC900 中的部分 14 脚 DIP 封装； 

该仿真头组件适用的器件型号为：P89LPC914/913/912 的 DIP14 封装。 

 

仿真头电缆插座 

用户测试接地端                                                        电源指示 

                                           

                                              仿真     DIP14 仿真插座 

振荡板                        晶振插座  

左            晶振插座  S1 S2 S3 S4 

 

图 7.3  仿真头结构示意图（正面俯视） 

 

z 仿真头主板 

 

仿真头电缆插座： 使用时用仿真电缆连接仿真器和仿真头。 

用户测试接地端： 用户在进行测试时，可以使用该端作为地参考点。 

振荡板： 如果您选择使用了仿真头时钟，您必须将振荡板插入仿真头主板，并在晶振插座

位置插入合适频率的晶振。 

DIP14 仿真插座： 用于连接仿真器和用户目标板。 

电源指示：  仿真头插入仿真器主机或仿真头电源脚有电压输入则该 LED 点亮。 

转换跳线：  S1/S2/S3/S4 为 4 组转换跳线，每一组跳线上下选择，形成不同的组合用于仿真

P89LPC914/913/912 时使用。 

 

跳线位置 
仿真器件 

S1（切换 6 脚） S2（切换 9 脚） S3（切换 8 脚） S4（切换 7 脚）

P89LPC914 上（P11） 上（P10） 下（P24） 下（P12） 

P89LPC913 上（P11） 上（P10） 上（P30） 上（P31） 

P89LPC912 下（P12） 下（P24） 上（P30） 上（P31） 

 

z 仿真电缆 

 

仿真电缆为 40 芯扁平电缆。 

 

z 振荡板 

 

振荡板是一块单独的 PCB 板，用于产生外部时钟，需要时可以插入仿真头主板（注意插入方向）。振

荡板在使用时必须在上面的晶振插座上插入正确频率的晶体。注意 TKS-900 的最高频率为 12MHz。 
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7.4 TB901-DIP8 

 

8 脚 DIP 插座仿真头，用于仿真 P89LPC900 中的部分 8 脚 DIP 封装； 

该仿真头组件适用的器件型号为：P89LPC904/903/902/901 的 DIP8 封装。 

 

仿真头电缆插座 

用户测试接地端                                                        电源指示 

                                           

                                                   3 个 DIP8 仿真插座 

振荡板                         

左            晶振插座   

 

图 7.4  仿真头结构示意图（正面俯视） 

 

z 仿真头主板 

 

仿真头电缆插座： 使用时用仿真电缆连接仿真器和仿真头。 

用户测试接地端： 用户在进行测试时，可以使用该端作为地参考点。 

振荡板：  如果您选择使用了仿真头时钟，您必须将振荡板插入仿真头主板，并在晶振插座

位置插入合适频率的晶振。 

仿真 3 个 DIP8 插座：用于连接仿真器和用户目标板。用户在仿真 P89LPC904/903/902/901 中的一个器

件时，需要将仿真头背面的 8 脚插针插入对应的器件位置上。 

电源指示：  仿真头插入仿真器主机或仿真头电源脚有电压输入则该 LED 点亮。 

 

注意：该装置的作用是使用用户板上的电源给内部仿真芯片供电，而不是给外部的目标板供电！ 

 

z 仿真电缆 

 

仿真电缆为 40 芯扁平电缆。     

 

z 振荡板 

 

振荡板是一块单独的 PCB 板，用于产生外部时钟，需要时可以插入仿真头主板（注意插入方向）。振荡

板在使用时必须在上面的晶振插座上插入正确频率的晶体。注意 TKS-900 的最高频率为 12MHz。 
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7.5 TB906-DIP8 

 

8 脚 DIP 插座仿真头，用于仿真 P89LPC900 中的部分 8 脚 DIP 封装； 

该仿真头组件适用的器件型号为：P89LPC908/907/906 的 DIP8 封装。 

 

仿真头电缆插座 

用户测试接地端                                                        电源指示 

                                           

                                                      3 个 DIP8 仿真插座 

振荡板                         

左            晶振插座   

 

图 7.5  仿真头结构示意图（正面俯视） 

 

z 仿真头主板 

 

仿真头电缆插座： 使用时用仿真电缆连接仿真器和仿真头。 

用户测试接地端： 用户在进行测试时，可以使用该端作为地参考点。 

振荡板：  如果您选择使用了仿真头时钟，您必须将振荡板插入仿真头主板，并在晶振插座

位置插入合适频率的晶振。 

3 个仿真 DIP8 插座：用于连接仿真器和用户目标板。用户在仿真 P89LPC908/907/906 中的一个器件时，

需要将仿真头背面的 8 脚插针插入对应的器件位置上。 

电源指示：  仿真头插入仿真器主机或仿真头电源脚有电压输入则该 LED 点亮。 

 

z 仿真电缆 

 

仿真电缆为 40 芯扁平电缆。     

 

z 振荡板 

 

振荡板是一块单独的 PCB 板，用于产生外部时钟，需要时可以插入仿真头主板（注意插入方向）。振荡

板在使用时必须在上面的晶振插座上插入正确频率的晶体。注意 TKS-900 的最高频率为 12MHz。 
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7.6 TB9401-D64 

 

64 脚插座仿真头，用于仿真 P89LPC9401。 

 

 

仿真头电缆插座 

 

用户测试接地端                                                                      

晶振插座                                                                           电源指示 

振荡板 

 

 

 

D16 仿真插座 

 

 

 

左                                       JP1      JP2 

 

图 7.6  仿真头结构示意图（正面俯视） 

 

z 仿真头主板 

 

仿真头电缆插座： 使用时用仿真电缆连接仿真器和仿真头。 

用户测试接地端： 用户在进行测试时，可以使用该端作为地参考点。 

振荡板：  如果您选择使用了仿真头时钟，您必须将振荡板插入仿真头主板，并在晶振插座

位置插入合适频率的晶振。 

电源指示：  仿真头插入仿真器主机或仿真头电源脚有电压输入则该 LED 点亮。 

D16×4 仿真插座： 用于连接仿真器和用户目标板。 

转换跳线： 当使用液晶驱动时使用。JP1 为 3 组转换跳线，用于将 LCD 的 SDA、SCL 和 OSC

分别与主控的 SDA、SCL 和 VDD连接起来；JP2 为 2 组转换跳线，作用是在 PIN16

（SDA）和 PIN17（SCL）上加两个上拉电阻时。当用户板本身没有加上拉电阻

时需要短接 JP2，以便能进行正常的 I2C 操作。 

 

 

 

 

 

 

跳线编号 跳线端子 1 跳线端子 2 注 

J1.1 VDD PIN26(VLCD) VLCD接 VDD 

J1.2 PIN64(SCLLCD) PIN17(SCL) 接通 I2C SCL 连接J1 

J1.3 PIN63(SDALCD) PIN16(SDA) 接通 I2C SDA 连接

J2.1 PIN16(SDA) 10K 上拉电阻 添加 I2C 上拉电阻
J2 

J2.1 PIN17(SCL) 10K 上拉电阻 添加 I2C 上拉电阻
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z 仿真电缆 

 

仿真电缆为 40 芯扁平电缆。 

 

z 振荡板 

 

振荡板是一块单独的 PCB 板，用于产生外部时钟，需要时可以插入仿真头主板（注意插入方向）。振荡

板在使用时必须在上面的晶振插座上插入正确频率的晶体。注意 TKS-900 的最高频率为 12MHz。 

 

z D16×4 仿真插座 

 
P89LPC9401 为一款表贴封装（LQFP64）的 MCU。标准的 LQFP64 仿真头价格昂贵，而且有焊接次数

的限制。因此 TB9401 采用 D16×4 的仿真插座以便于用户手工焊接，通过插座后和仿真器就能方便的拔插。 

用户可以用较细的连接导线将 PCB 板上的表贴封装焊盘引出，接到仿真器的插座 D64 上，其插针的排

列与 P89LPC9401 的封装是一一对应的。 

注意：连接导线尽量短。由于导线和焊盘的焊接面积较小且密度较大，要求用户的手工焊接技术较高，

用户应仔细/认真的焊接。焊接完成后检查无误，有条件的话要在封装的中心用热溶胶将导线固定，以免多

次晃动导线引起脱焊！ 

另外，用户也可以使用 P89LPC9401 PACK 转换板，其封装与 TB9401-D64 兼容，以方便对用户系统的

仿真。具体方法是：用户在用户系统中安装一个 PACK 板的母座，当仿真的时候，将仿真头 TB9401-D64 插

入母座即可使用仿真器仿真；当用户要使用芯片运行程序时，则将 PACK 板插入母座即可。 
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7.7 TB915-DIP14+2 

 

14/16 脚 DIP 插座仿真头，用于仿真 P89LPC900 中的部分 14/16 脚 DIP 封装； 

该仿真头组件适用的器件型号为：P89LPC917/916 的 DIP16 封装、P89LPC915 的 DIP14 封装。 

 

仿真头电缆插座 

                                                                                

用户测试接地端                                                                      电源指示 

                                                             DIP16 仿真插座 

振荡板                         

                                                               DIP14 仿真插座 

 

左           晶振插座         S1 S2 S3 S4 

 

图 7.7  仿真头结构示意图（正面俯视） 

 

z 仿真头主板 

 

仿真头电缆插座： 使用时用仿真电缆连接仿真器和仿真头。 

用户测试接地端： 用户在进行测试时，可以使用该端作为地参考点。 

振荡板： 如果您选择使用了仿真头时钟，您必须将振荡板插入仿真头主板，并在晶振插座

位置插入合适频率的晶振。 

DIP14 仿真插座： 用于连接仿真器和用户目标板，仿真 P89LPC915。 

DIP16 仿真插座： 用于连接仿真器和用户目标板，仿真 P89LPC916、P89LPC917。 

电源指示：  仿真头插入仿真器主机或仿真头电源脚有电压输入则该 LED 点亮。 

转换跳线：  S1/S2/S3/S4 为 4 组转换跳线，每一组跳线上下选择，用于仿真 P89LPC917/916

时使用。当 4 组跳线均为下选择时，仿真 P89LPC917；当 4 组跳线均为上选择时，

仿真 P89LPC916。 

 

跳线位置 
仿真器件 

S1（切换 5 脚） S2（切换 2 脚） S3（切换 6 脚） S4（切换 11 脚）

P89LPC917 下（P22） 下（P00） 下（P14） 下（P07） 

P89LPC916 上（P23） 上（P24） 上（P22） 上（P25） 

 

z 仿真电缆 

 

仿真电缆为 40 芯扁平电缆。 

 

z 振荡板 

 

振荡板是一块单独的 PCB 板，用于产生外部时钟，需要时可以插入仿真头主板（注意插入方向）。振

荡板在使用时必须在上面的晶振插座上插入正确频率的晶体。注意 TKS-900 的最高频率为 12MHz。 
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八、TKS-900 仿真器的限制 
 

任何仿真器都不能完全真实的仿真，TKS-900 也不例外。由于 P89LPC900 系列在外设方面的复杂变化，

使完全仿真 P87LPC900 更加困难！ 

 

z TKS-900 要动态地占用 2 个堆栈。这种原因是由于 BondOut 仿真芯片决定的。建议用户在程序的上部

多预留 2 个堆栈的位置。 

 

z TKS-900 不能仿真掉电复位。由于 BondOut 芯片要求按照规定的时序进行工作，因此对于掉电引起的

BondOut 芯片复位将是致命的，会引起仿真系统的彻底紊乱。这是因为仿真监控系统无法感知同

BondOut 芯片通讯失败是何种原因引起的。如果用户想使用掉电复位功能，建议用户这样处理：不使

用掉电复位，但是开放掉电中断。在掉电中断处理程序中加入一条软件复位指令：ORL AUXR1，#08H，

这样虽然关闭掉电检测复位功能，但是在掉电后仍能通过软件复位达到目的，这种方法是可行的。如

果用户在程序中使用指令开启掉电复位，真正掉电时会引起仿真器死机！ 

 

z 由于 89LPC932 内部具有实时时钟等新型外设，所以从用户程序返回监控状态定时器 T0/T1 要多运行一

段时间才会关闭，所以单步运行一条指令 T0/T1 要多运行大约 10 个机器周期；全速运行大约也要多运

行 10 个左右的机器周期。 
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九、TKS-900 使用中的常见问题 
 
1． TKS-900 同计算机通讯失败 

 
如果出现通讯失败将无法进入硬件仿真，出现这种现象的原因一般是： 

z 仿真器同 PC 的通讯电缆连接不良。 

z 仿真器没有电源。 

z 错误的选择了仿真器硬件驱动程序。 

z 串口选择错误，或者该串口已经被其它设备占用。 

z 计算机串口已经损坏。 

z 用户已经进入了硬件仿真，退出仿真环境后又改变了波特率数值，这时重新进入仿真环境后由于 

波特率改变而无法通讯。解决的办法是在改变波特率后一定对 TKS-900 重新上电复位。 

 

2．步运行后仿真器会进入“死机”状态，且运行和监控指示灯全部点亮 

 

这种现象一般出现在 C 语言调试中，或者 C 语言和汇编语言混合调试中。如果当用户当前的源程序窗 

口是 C 源程序，但是当前 PC 的位置却并没有在 C 源程序的有效范围内，单步运行实际上是要求仿真器单步

运行一条 C 程序语句，到下一条 C 程序语句位置停止。由于当前的 PC 位置并没有处于 C 的有效位置，因

此仿真器只能单步运行每一条汇编程序到下一条 C 程序语句位置。如果这期间的汇编语句较多，可能会耗费

较多的时间。仿真器连续的单步运行，不再接收其它命令，好像进入死机状态。连续快速的在单步运行和监

控中切换，所以监控和运行指示灯会全亮。 

例如，如果用户当前的 PC=0，这时在 C 源程序中不会有程序运行指示，但是在汇编窗口中运行指示 

在 PC=0000H 位置。如果用户把当前的窗口点击为 C 程序窗口，则仿真器认为下一个单步将运行到 main()

函数位置，在用户要求单步运行后将单步运行 PC=0000H 到 main()函数期间的所有汇编指令，可能要耗费较

多的时间。 

采用全速运行加断点的方式可以解决这个问题。 
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十、TKS-900 的升级 
 

TKS-900 的用户享受不定期的升级服务，其中包含免费的软件升级。请定期留意我们的主页上的升级

信息，或直接使用技术支持电话询问升级事项。 

 

 

十一、 结束语 
 

TKS-900 是一款经过精心设计的 89PLPC900 单片机仿真器，能最大限度的满足仿真时的各种需求。在

软件上仍保留了同 Keil 软件的接口，使 Keil 的用户能在自己熟悉的平台上编译调试程序，这种方法也大大

增加了 TKS-900 的实用性。 

TKS-900 的用户会得到亚洲最专业的技术支持，无论是 TKS-900 仿真器的使用，还是 P89LPC900 单片

机的应用。如过您遇到任何关于 P89LPC900 单片机的问题，请致电我们的技术支持，也可以访问我们的公

司主页( http://www.edmarket.com.cn )。 

 


